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REVISION HISTORY
This section summarizes significant changes, corrections, and additions to the document. The
history appears in chronological order with the most recent changes listed first.

Version 3
Small update to the document includes a change to the General Settings instructions to include the
New Login Each Poll checkbox.
Chapter 2): Installing the DataMotion Adapter
n

Installation Requirements (below ): Added new checkbox to the General Settings screenshot

and description.

Version 2
Small update to the document includes a change to the General Settings instructions to include the
New Login Each Poll checkbox.
Chapter 3): Using the DataMotion Adapter
n

General Settings (below ): Added new checkbox to the General Settings screenshot and

description.

Version 1
Initial version of this document, which provides information on DataMotion Adapter v3.6. This
document incorporates content from previously published documents. Some of the information in
this document was previously published in the following documents:
n

DataMotion Adapter Integrator’s Guide, v. 2.1 (last published October 23, 2011).
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About This Publication

BRIEF DESCRIPTION
The DataMotion Adapter (DMA) provides an automated means for polling selected user accounts
on the DataMotion Secure Message Server and retrieving their messages and/or file attachments
through a secure channel. It downloads them into the local file system of the host computer where
the DMA is installed, so they can be accessed and used by other application programs.
This publication documents the installation, configuration, and operation of the DMA.
NOTE: This publication documents DataMotion Adapter v3.6 and later.

INTENDED AUDIENCE
This publication is intended for a technical audience, including engineers, developers, programmers,
system administrators, and system and application integrators.
Additional technical documentation, as well as user documentation, is also available from
DataMotion. See DataMotion Documentation on page 2.

HOW TO USE THIS PUBLICATION
The content is organized as follows:
About This Publication .

Provides an overview of the content of this publication and how to use the publication.
Chapter 1) Introduction

Provides an overview of the DataMotion Adapter, including a description of its features.

Chapter 2) Installing the DataMotion Adapter

Provides step-by-step instructions to install the DataMotion Adapter.

Chapter 3) Using the DataMotion Adapter

Describes in detail how to configure, operate, test, and troubleshoot the DataMotion
Adapter.
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Chapter 4) DataMotion Adapter Files

Provides information on some pertinent DataMotion Adapter files and related
information.

Appendix A: Supplemental Information

Provides supplemental information on Filtering, Downloading, Saving, Deleting, and Track
Sent.

RELATED INFORMATION
DATAMOTION DOCUMENTATION
n

n

n

DataMotion SecureMail Software Development Kit Technical Reference Manual (part # 050002)
Documents the Application Programming Interfaces (APIs), and system development,
maintenance, and administration tools for partners, developers, system integrators and
administrators to provision and manage the system, and to customize and integrate with
existing workflows.
DataMotion SecureMail User Guide (part # 050004)
Provides instructions for using the products.
DataMotion SecureMail Administration Guide (part # 050006)
Documents the system installation, maintenance, and administration tools for
administrators and integrators.

Additional documentation is available on many other topics. Please contact DataMotion
Customer Service for more information.

„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ

About This Publication
Copyright © 2008 – 2020, DataMotion, Inc. All rights reserved.

Page 2

/ SecureMail
Adapter Guide

v3

1
Introduction

OVERVIEW
The DataMotion Adapter (DMA) provides an automated means for polling selected user accounts
on the DataMotion Secure Message Server and retrieving their messages and/or file attachments
through a secure channel. It downloads them into the local file system of the host computer where
the DMA is installed, so they can be accessed and used by other application programs.
NOTE: When this document refers to secure “messages,” it is meant to include both
messages and/or file attachments, unless it is explicitly stated otherwise or obvious from
the context that it applies only to the message body without attachments.

The DataMotion Adapter (DMA) is a utility program and a Windows service.
n

n

The DMA Utility program (DownloadManager.exe) allows you to configure the
operation of the DMA Service and to start, stop, and restart the service. It also provides
logging and testing tools.
The DMA Service is a background Windows service named DataMotion Adapter that
polls for messages and downloads them to the local host based on the DMA
configuration.
NOTE: The local host, or client, computer is the computer on which the DMA is
installed and which downloads messages from the DataMotion Secure Message
Server.

One way that DMA can be used is to install it on desktop PCs so that individual users can access
directly from their PCs secure email and attachments sent to them through the DataMotion Server.
(When using the DMA, desktop users do not need to log into the DataMotion Server to retrieve
their secure messages, nor do they need to be aware of the secure email account or the desktop
service that supplied these files.) This usage is not very common because DataMotion SecureMail
can be used on a variety of clients, including smartphones, tablets, as well as desktop clients.
Another way that DMA can be used is to install it on a server so that it provides an application
program with message and file content for purposes of customization. For example, an Electronic
„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ
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Health Record (EHR) vendor could incorporate into their systems the data submitted in
DataMotion Secure eForms, and the DMA provides an automated way to accomplish this, as well as
many other things.
The DMA Service uses an SSL connection to the DataMotion Messaging Web Service (CMv4) to
download messages securely to the client via SOAP. Messages can be retrieved in standard SMTP
format, allowing them to be opened in email clients (such as Microsoft Outlook Express, Windows
Live Mail, or Thunderbird) or to be parsed by third-party software packages. The DMA can also be
configured to expand DataMotion messages and save their attachments separately, and optionally, it
can deliver the text and HTML bodies into the file system for direct access to the message parts with
no MIME parsing required. By default, downloaded messages are saved in the Downloads folder
under the DMA installation folder.

FEATURES
The DataMotion Adapter Utility allows you to select the secure accounts to be polled on the
DataMotion Secure Message Server, supply the required credentials, establish the polling interval,
filter the messages to be retrieved from the user’s secure messaging account, and control the format
of how those messages are stored on the local host, among other things.
The DataMotion Adapter provides the following features:
n

n

n
n

n
n

The DMA Utility program provides a Graphical User Interface for configuration,
administration, and testing of the DMA Service. The Testing options include the ability
to verify proper communication with the DataMotion Server and to perform a
Download for any configured user account.
The DMA Service polls secure message accounts on a DataMotion Server and securely
downloads messages and/or attachments over SSL to the local host file system.
The DataMotion Server can be cloud-hosted or on-premises.
Multiple user accounts can be serviced from one configuration with the option to
customize download settings for each user.
The polling interval is configurable.
You can specify filtering options to download messages according to your criteria,
including:
» Download messages from the Inbox folder only, or from the Inbox folder and its
subfolders, or from a specified folder.
» Download all messages or only those with attachments.
» Download Unread messages only (“New” messages), or download all messages
(both Read and Unread) that have not already been downloaded. This option allows
you to keep a cache on the local host of those messages that have been opened or
Read (“Old” messages). Therefore, you can choose to cache Read messages on the
local host, the DataMotion Secure Message Server, or both.
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You can select the location to save the downloaded files and you can specify whether
you want the messages to be saved in sub-folders that identify the recipient, the sender,
and the Message ID.
You can also specify file format and save options for downloaded messages and
attachments, and you can specify filtering for attachments. Save Options include:
» MIME-encoded EML file (a single file in standard SMTP format).
» Body and Attachments as Separate Files (the message body is saved as a text and/or
HTML file).
» Only Body (the message body is saved as a text and/or HTML file).
» Only Attachments (the message body is not saved).
» Only Attachments Matching One or More File Patterns (the message body is not
saved).
For all Save methods: When new messages are downloaded, Track Sent Messages will
report they have been opened and trigger notification to the senders. This includes
message body and all attachments (if any).

n
n

n

Messages can be deleted from the DataMotion Server after being downloaded.
The DMA Service can log its activity, and you can specify the location for the log files.
The Logging Level is configurable and includes a Test Mode that can be used to
diagnose issues or test the DMA Service.
DMA provides an application hook; that is, a way to hand off the downloaded messages
and attachments to an application program. This allows application programs to process
the content and customize it to fit a given workflow.

HOW TO SET UP THE DATAMOTION ADAPTER (A SUMMARY)
For requirements, see:
n

Installation Requirements (on page 6)

n

Operating Requirements (on page 11)

To set up the DataMotion Adapter, perform the following steps:
1. Install the DMA software on the local computer: Use the instructions in Chapter 2)
Installing the DataMotion Adapter on page 6.
2. Configure and test the DMA Service: Use the instructions in the Chapter 3 section
Configuring the DataMotion Adapter on page 12.
3. Start the DMA Service: Use the instructions in the Chapter 3 section Operating the
DataMotion Adapter Service on page 28.
4. If you encounter any problems, refer to Troubleshooting on page 29.
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2
Installing the DataMotion Adapter

To obtain the DataMotion Adapter (DMA), you may download it from the DataMotion Server. You
will find it under the “Client Downloads” section in your Member Center. If you do not see
“DataMotion Adapter” in the drop down list or do not see Client Downloads in your Member
Center, you do not have permission to download this product. In this case, you should contact your
support representative to inquire about adding this functionality to your account.

INSTALLATION REQUIREMENTS
NOTE: See also Operating Requirements on page 11.

Before installing the DataMotion Adapter (DMA) on a host Windows computer, the host must meet
the following requirements:
n

You must have administrator privileges on the host computer to install the software
package.

n

The host computer must use Windows 7, Windows 8 or Windows 10 OS.

n

Windows Server 2008 R2 or a later version of Windows Server is necessary.

n

Prior to running the DMA Service, the host computer must have installed
Microsoft .NET Framework v4.5 or later, either the .NET 4.5 Client Profile or 4.5
Full/Extended.
NOTE: The DMA setup program detects if the .NET Framework is installed, and if
not, it will initiate a wizard to obtain it.

SETUP PROCEDURE
The DataMotion Adapter Windows Installer Package file is named similar to
SetupAdapterXXX.msi (where XXX represents the version number). It contains all files
necessary for the successful installation of the DMA Service. The following setup assumes that you
have downloaded or copied the DataMotion Adapter Windows Installer Package file to a folder on
the host computer.
„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ
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1. To begin the installation, using Windows Explorer, right click the filename of the
DataMotion Adapter Windows Installer Package and select Install, or double-click the
filename to run it.
2. If .NET Framework 4.5 is not already installed on the host computer, the setup program
asks if you want to obtain it now:

A. Select Yes, and the setup program opens a browser window to the Microsoft .NET
Framework page so you can download and install it.
B. On the .NET Framework page, select .NET Framework 4.5 from the .NET
Framework Downloads List.

C. Then select Download to download and install the .NET Framework package on
the computer.
D. After you have installed the .NET Framework, you can download and install updates
for it using Windows Update, or you can wait until later.
E. Once .NET Framework is installed, run the DataMotion Adapter setup program
again and continue with the procedure.
3. If the DataMotion Adapter software is already installed when you run the setup program,
it will ask if you want to Repair or Remove (uninstall) the software, and you can select
one of these or cancel the setup. Otherwise, if this is a new installation of the software, a
welcome screen similar to the following is displayed.
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4. Click Next to continue. The setup program displays a screen similar to the following
asking you to select an installation folder:

5. To select the Folder location where you would like the program installed, click the
Browse button to browse for and select the program, or enter a fully qualified path and
folder name in the text box. The default installation folder is C:\Program
„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ
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Files\DataMotion\DataMotion Adapter Service, or C:\Program
Files\(x86)\DataMotion\DataMotion Adapter Service if using a 64-bit operating system.
(You can click the Disk Cost button to determine if your requested location has enough
free space.)
After selecting the installation folder, select which users of this host computer you want
the software to be installed: Everyone or Just me.
When you are ready, click Next to continue.
The setup program verifies that your selections are valid and displays a confirmation
screen similar to the following:

6. When you are ready, click Next to install the software.
The setup program installs the software on the host computer while displaying a
progress indicator bar.
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7. When all the files have been installed, the “Installation Complete” screen is displayed,
indicating that the DataMotion Adapter has been successfully installed.

8. Click Close to exit the setup program.
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3
Using the DataMotion Adapter

The DataMotion Adapter (DMA) Utility program allows you to configure the operation of the
DMA Service and to start, stop, and restart the service. It also allows you to test the host computer’s
connection to the DataMotion Server and perform a Download from any user account. This section
includes the following information:
n

Operating Requirements (below)

n

Configuring the DataMotion Adapter (on page 12)

n

Operating the DataMotion Adapter Service (on page 28)

n

Troubleshooting (on page 29)

OPERATING REQUIREMENTS
n

n

n

n

To run the DMA Service, the host must have Port 443 open to be able to use an SSL
connection to access the DataMotion Server to SSL.DataMotion.com.
To download messages from a user account, at least one user must be configured to use
the DMA Service.
To download messages from a user account, you must supply the required user account
credentials. The credentials include the User ID or email address and the account
password, which are used to identify the account and provide authorization. (To protect
the account against unauthorized access, the password is stored as a token.) See also User
ID on page 21.
To download messages from a user account, the Web Services API Integration feature
must be enabled for the account. This feature allows the DMA, and other application
programs, to interface with the Web Services API and access the DataMotion Server
programmatically. To inquire about enabling this feature, contact your support
representative. For information about what happens when the feature is not enabled, see
Troubleshooting on page 29.
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CONFIGURING THE DATAMOTION ADAPTER
You must configure the operation of the DMA Service before using it. The DMA Utility Program
allows you to configure the operation and save the settings.
RUNNING THE DATAMOTION ADAPTER UTILITY PROGRAM
To start the DataMotion Adapter Utility program, click the Windows Start menu, click
DataMotion, and then click DownloadManager. (Alternatively, you can navigate to the
installation folder and run the DownloadManager.exe program.)
Before starting the DMA Service , you must use the DMA Utility to configure these settings:
n

n

General Settings (below)

These settings include File and Server Paths, Polling Interval, and Logging Level. In
General Settings, you can also test proper communication with the DataMotion Server.
User Settings (on page 16)

These settings include providing the DataMotion account credentials for the user
accounts to be polled and controlling message downloading through message filtering,
file format and save options, using a local message cache, deleting server messages after
download, and handing off the saved messages to an application program. From the
User Settings, you can also perform a Download Now for a configured user.

GENERAL SETTINGS
1. When you run the DataMotion Adapter Utility program (DownloadManager.exe) as
described in Running the DataMotion Adapter Utility Program above, the utility screen is
displayed with the General Settings tab selected, similar to the following:
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2. Fill in the applicable fields according to the information that follows:
n

SecureMail Web Service URL: Specifies the URL of the DataMotion Server
Messaging Web Service (CMv4). If you use a DataMotion cloud-hosted server or an onpremises server, enter that server name in the path. Standard URLs include the
following:
- For DataMotion SecureMail customers:
https://ssl.datamotion.com/cmv4/cmv4.asmx
h For DataMotion Direct customers:
https://ssl.dmhisp.com/cmv4/cmv4.asmx

n

Test button: Click Test to verify proper communication with the DataMotion Server
Web Service. (The DMA uses an SSL connection on Port 443 to access the DataMotion
Server Web Service.) If successful, the following message is displayed:
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Polling interval (minutes): Specifies how often, in minutes, the DMA Service will poll
the DataMotion Server for new messages. When this interval elapses, every user account
that is configured and enabled will be polled. Selectable values include: 5, 10, 15, 30, 60.
The selected value will depend upon the application. A polling interval of five (5)
minutes is common when downloading messages for desktop users.
Log File Path: Specifies the location where log files are written. To specify a subfolder
relative to the installation folder, include “.\” in front of the path. The log file path must
specify path information only. The DMA automatically generates a filename for each log
file as needed. The filename is determined by the date when the log file is created. Each
time the DMA Service is started or restarted, a new SVC log file is created. Service
logging only occurs while the DMA Service is running. (See Log Files on page 32.) Enter
the path or click the Browse button to select a folder. Click the View button to open
the selected folder in an Explorer window. The default location for log files is the Logs
folder under the DMA installation folder; that is: “.\Logs\”.
Download Path: Specifies the location where downloaded message files are saved. This
is the “root” folder used to store message files; for example: C:\Data\DataMotion
Adapter\Downloads\. To specify a subfolder relative to the installation folder, include
“.\” in front of the path. The download path must specify path information only. The
DMA automatically creates filenames for all saved files as needed. (See Downloaded
Message File Names on page 31 for details.) Enter the path or click the Browse button
to select a folder. Click the View button to open the selected folder in an Explorer
window. The default location for saved files is the Downloads folder under the DMA
installation folder; that is: “.\Downloads\”. See also Download Path Type for more
information.
Download Path Type: Specifies the type of directory/folder structure for saving
downloaded files. Settings include:
» Save downloads to one directory – All files will be saved in the Download Path
folder. This is the recommended setting.
» Save downloads to directory tree – Files will be saved in a directory structure
below the Download Path folder. For each message, the tree structure under the
download path will be as follows:
.\<Recipient-User-ID>\<Sender-Email-Address>\<MID>\
For Example:
C:\Program Files\DataMotion\DataMotion Adapter Service\
Downloads\JohnDoe@Receive.Com\JaneDoe@Send.Com\21274916\
The <MID> is the Message ID that is unique on the DataMotion Server. (The MID
is displayed in the DataMotion secure messaging web portal as one of the columns in
the user’s Inbox.)
If you use this setting, the <Sender-Email-Address> must not contain any nonstandard file system characters for the client’s operating system; otherwise the OS
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will not be able to create the folder and will generate an error. To avoid this, set the
download path to Save downloads to one directory.
The <Recipient-User-ID> is the user’s email address or User ID. For more
information on the <Recipient-User-ID> and non-standard file system characters,
see User ID on page 21.
n

Logging Level: Enables/Disables logging and specifies the level of detail that is written
to the log files. DMA Service logging only occurs while the service is running. (To start
the service, see Operating the DataMotion Adapter Service on page 28.) Settings include:
» Off – Disables data logging.
» Log Errors – Logs error information only. Errors indicate that something is
configured incorrectly or behaving erratically. For example: “Communication
Failure.”
» Log Errors and Warnings – Logs warnings as well as error information. Warnings
are items that may cause concern but are not errors in how the system behaves. For
example: “Authentication Failed.”
» Log Errors, Warnings and Information – Logs error information, warnings, and
information. Information includes control items such as when the service is started
or stopped, as well as stack trace information when an error occurs. This is the
default setting and is recommended for typical use. It does not increase the log size
until an exception occurs.
» Verbose Logging – Test Mode – Logs all DMA actions in very detailed data. This
option should not be used except when diagnosing a potential problem. Every timetick and action is logged, creating a rapidly growing log file.

n

New Login Each Poll: For every poll made by the Adapter during its set interval in the
Polling interval (minutes) drop-down, a new login will be made for each request. This
makes the connections more reliable as each polling request will have its own session
and not have to rely on an in place connection to remain open.

3. After making changes to the General Settings , make sure to save your configuration. To
save your configuration, click the Save button on the toolbar:
. Or you can:
» Click the File menu.
» Click Save Settings.
4. After you have completed the General Settings, configure the User Settings according to
the information in User Settings on page 16.
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USER SETTINGS
Before you use the DMA Service, you must configure User Settings.
These settings include providing the DataMotion account credentials for the user accounts to
be polled and controlling message downloading through message filtering, file format and save
options, using a local message cache, deleting server messages after download, and handing off
the saved messages to an application program. From the User Settings, you can also perform a
Download Now for a configured user.
The following instructions describe how to configure User Settings.
1. If the DataMotion Adapter Utility program is already running, skip this step. Otherwise,
run the DMA Utility program as follows: Click the Windows Start menu, click
DataMotion, and then click DownloadManager.
2. Click the User Settings tab to display a screen similar to the following:

Default Download Settings
Default Download Settings apply to all users. You can override these settings for individual
users through Custom Download Settings (see Add User and Customize Download Settings on
page 21).
1. Click the Default Download Settings button, and the program opens the Default
Download Settings dialog, similar to the following, which allows you to configure
default settings for all users.
„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ
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2. Fill in the applicable fields according to the information that follows:
n

Download from Folder: Specifies whether to download messages from the Inbox
folder only or the Inbox folder and its subfolders (or a specific folder ID when
using Custom Download Settings), as follows:
» Inbox – Only the Inbox folder will be polled. (Default.)
» Inbox & Subfolders – The Inbox folder and its subfolders will be polled.
» Inbox Folder ID – (Custom Settings Only). Only the specified folder will be
polled. The Inbox Folder ID option applies (and is shown) only when you are
configuring Custom Download Settings for a specific user. (See Add User and
Customize Download Settings on page 21.)

The folder IDs for users are assigned sequentially on the DataMotion Server.
For example, if a user creates a folder named Images, it is assigned the next
sequential folder ID on the DataMotion Server, such as 45994. You can find
out the folder IDs assigned to users either programmatically or manually. To
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discover folder IDs programmatically, use the Messaging API GetMailboxXML
method (see the DataMotion SecureMail Software Development Kit Technical Reference
Manual for details). To do it manually, log in to the DataMotion web portal, go
to Member Center, and select Folders. On the Manage Folders page, point to
the name of a user-defined folder, and the status bar will show the folder ID at
the end of the URL, e.g., “?f=45994”. (Alternatively, you can click on the folder
name to see the URL in the address bar.)
Standard Folder IDs include:
» -1: Inbox and subfolders (same as the standard setting “Inbox &
Subfolders”).
» 0: Inbox only (same as the standard setting “Inbox”).
» 1: Inbox only (same as 0 but retains the Inbox Folder ID).
» 2: Inbox Trash folder.
» 3: Outbox (Track Sent) folder.
» 4: Outbox Drafts folder.
» 5: Outbox (Track Sent) Trash folder.
» 6: Outbox (Track Sent) Archive folder.
» 7: Inbox Deleted Trash folder.
» 8: Outbox (Track Sent) Archive folder.
n

Download all messages or only those with attachments: Filters what is to be
downloaded, as follows:
» All messages – Download messages regardless of whether they contain
attachments. (Default.)
» Only with attachments – Download only messages containing attachments.

n

Purge message from SecureMail account after downloading: Specifies
whether to delete the message from the user’s account on the DataMotion Server
after it has been downloaded to the client, as follows:
» Yes – Messages are permanently deleted from the Inbox after they are
downloaded to the local host. The message is deleted completely. It is not
moved to the user’s Trash folder or Deleted Trash folder, and it cannot be
recovered after deletion.
» No – Messages are not deleted from the account after they are downloaded to
the local host. (Default.)

n

Client Message Cache: Specifies whether to cache user messages on the local
host, as follows:
» Enabled – Download all messages – When the cache is enabled, the DMA
downloads all messages (both Read and Unread) that are not listed in the cache
control file and then adds their IDs to file. Thus, messages are downloaded:
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A) Regardless of the message status on the DataMotion Server; that is, it
downloads both Read and Unread messages (“Old” and “New” messages), and
B) When the message ID is not already listed in the cache control file.
This option allows you to keep a cache on the local host of those messages that
have been opened or Read (“Old” messages). The client download cache
control file is named DownloadCache.txt, and it is stored under the Downloads
folder in a folder named with the recipient’s User ID. (See User ID on page 21.)
If the DownloadCache.txt file is renamed, moved, or removed, in effect it will
clear the cache record, and at the next polling, all existing messages can be
downloaded (depending upon the specific settings) and their message IDs will
be listed in the new cache control file.
» Disabled – Only download New messages – When the local message cache
is disabled, only Unread messages (“New” messages) on the DataMotion Server
will be downloaded. The cache control file is not used. (Default.)
n

Save Method: Specifies and filters the file types and format used for saving
downloaded messages, as follows:
NOTE: For additional information on file names, see Downloaded Message
File Names on page 31.
NOTE: For all Save methods, Tracking of the sent message will report that
both the message and all its attachments (if any) have been opened. For
more information, see Filtering, Downloading, Saving, Deleting, and Track Sent
on page 34.

» Save Entire Message as MIME-encoded .eml file – (Default.) Saves
message including attachments as a single file in standard SMTP format. The
EML file format contains both the body and all file attachments. This format
allows the message to be opened in email clients or to be parsed by third-party
software packages. The filename will be <MID>.eml where <MID> represents
the Message ID that is unique on the DataMotion Server. Example:
21274916.eml. (The MID is displayed in the DataMotion secure messaging web
portal as one of the columns in the user’s Inbox.)
Note: If you save the message as an EML file and the General Settings
Download Path Type is set to use a directory tree structure, DMA creates a
Message ID folder containing an EML file also named with the Message ID.
» Save Body and Attachments as Separate Files (Body as .txt and/or .htm)
– Saves message body and attachments as separate files. The message body is
saved as <MID>_Body.txt and/or <MID>_Body.htm (if HTML body exists),
where <MID> represents the unique Message ID. (The MID is displayed in
the DataMotion secure messaging web portal as one of the columns in the
user’s Inbox.) The attachments are saved as decoded files using their original
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filename and in their original format; that is, in the format they existed before
they were sent. Example: 21274916_Body.txt, 21274916_Body.htm, Report.pdf.
» Save Only Body (as .txt and/or .htm) – Saves only the message body as
<MID>_Body.txt and/or <MID>_Body.htm (if HTML body exists), where
<MID> represents the unique Message ID. The attachments are not saved.
Example: 21274916_Body.txt, 21274916_Body.htm.
» Save Only Attachments – Extracts and saves only the message attachments as
decoded files using their original filename and in their original format. The
message body is not saved. Tracking of the sent message will report that both
the message and its attachments have been opened. If you use this Save
Method, typically you would also select the filter Only with Attachments to
avoid the possibly unwanted consequences of not saving messages that do not
have attachments. Example: Report.pdf.
» Save Only Attachments Matching One or More File Patterns – Extracts
and saves only the message attachments as decoded files using their original
filename and in their original format when the attachment filename matches a
specified pattern. The message body is not saved. Tracking of the sent message
will report that both the message and all its attachments have been opened. If
you use this Save Method, typically you would also select the filter Only with
Attachments to avoid the possibly unwanted consequences of not saving
messages that do not have attachments.
Attachment File Patterns: Specifies a comma separated list of filename patterns
to select attachments for saving. You can use the standard wildcard characters
of an asterisk (*) to match zero or more preceding or following characters, as
well as the question mark (?) to match any single character in that position.
Alphabetic characters are treated as case-insensitive. If you specify multiple
patterns, you must separate them with commas. (You can also use a commaspace to separate them, because the space is ignored.) Examples: *.txt, *.xml,
*.tiff, *form.pdf, Report*.*, July??2014.log, *.doc*
n

Post-Save Action: Specifies the name and location of an application program or
script to run after the message files have been saved, plus the optional %filename%
argument, which is used to pass to the program the full path and filename for the
file(s) that have been saved. The Post-Save Action executes the specified
application program and passes the filenames to that program, so that their content
can be integrated into a custom workflow by the program.
» Click the Program/Script button to browse for and select the program, or
enter a fully qualified path and program name in the text box.
» Enter any parameters for your program in the Arguments text box.
Use %filename% to pass a list of the saved files. If multiple files are saved for a
message, then the filenames will be separated by commas (i.e., the string value
will contain a Comma Separated Value list of fully qualified filenames with the
entire string enclosed in quotes). For example, if a message is saved with
separate files for body and attachments, and it contains an attachment named
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Report.pdf, the string passed to the Post-Save program in the %filename%
argument will be similar to the following:
“C:\Program Files\DataMotion\DataMotion Adapter
Service\21274916_Body.txt,C:\Program Files\DataMotion\DataMotion
Adapter Service\Report.pdf”
NOTE: For more details on how filtering works, especially in relation to how the filters
are applied to select messages for action (downloading, purging, saving), as well
as how the actions affect the message status on the DataMotion Server, see Filtering,
Downloading, Saving, Deleting, and Track Sent on page 34.

Add User and Customize Download Settings
At least one user must be configured to use the DMA Service.
1. On the User Settings tab, click the Add User button to add a user. The program
opens the User Download Settings dialog.

2. Fill in the applicable fields according to the information that follows:
n

User ID: (Required.) Specifies the DataMotion User ID or Email Address for the
user account that is to be polled by the DMA Service. This value is used to identify
and authenticate the account on the DataMotion Server so messages can be
downloaded.
This value will also be used as a folder name in the download directory structure on
the local host when:
A) General Settings specify a Download Path Type = “Save downloads to
directory tree” or
B) User Settings specify Download Setting of Client Message Cache = Enabled.
While it is unusual, email addresses may include symbols and characters such as
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\ / : * ? ″ < > |. The Windows operating system does not allow these characters
to be used in file/folder names. If the user’s email address contains any nonstandard file system characters for the client’s OS, the OS will not be able to create
the folder and will generate an error. To avoid this issue, you can assign the user a
friendly User ID that does not contain any of these non-standard characters, and
specify this User ID instead of the email address. (An administrator can assign the
User ID through Member Center> Administrative Tools> Manage Users> Update
User.)
NOTE: The User ID specified here is stored in UserList.xml (User List
Configuration File) on page 33.
n

Password: (Required.) Specifies the password associated with the DataMotion user
account. The password is case-sensitive and will be used to authorize the download
of the user’s messages by the DMA Service.
NOTE: To protect the user account against unauthorized access, the
Password specified here is stored as an encrypted token in UserList.xml (User
List Configuration File) on page 33.

n

n

User Enabled: Click the checkbox to enable or disable this user in the DMA
Service. When enabled, the user account will be polled by the service.
Download Settings: Click on the drop-down list and select either Default
Download Settings or Custom Download Settings for the user, as follows:
» Use Default – Selects the Default Download Settings that apply to all users.
Click the View button to view the default settings. (Note: The default settings
can be modified through the Default Download Settings button on the User
Settings tab.)
» Custom – Selects Custom Download Settings that override the default settings.
When you select Custom, the View button changes to an Edit button. Click the
Edit button to specify Custom Download Settings for this user account.
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3. When you click the Edit button, the Custom Download Settings dialog is displayed,
similar to the following, which allows you to specify settings for this user.

4. Set the fields to the desired values for this user. This will override the default
settings for this user. The fields have the same meaning as those in the Default
Download Settings. For a description of the fields, refer to Default Download
Settings on page 16.
NOTE: The option to Download from Folder using a Folder ID applies (and is
shown) only when you are configuring Custom Download Settings for a
specific user (see the screen above). It does not apply to, and is not shown
in, the Default Download Settings.

5. After selecting the Custom Download Settings for this user, click OK to return to
the User Download Settings dialog. From there, you can perform a Download
Now to try the settings if you want (see the Download Now button on page 24).
(Afterwards, make sure to click OK to finish adding the user.)
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Download Now button
You can perform a single Download from the User Download Settings dialog. (This
dialog is accessed from the User Settings tab when you Add User or Edit User.)

NOTE: If you want to perform a clean download on the local host, you may
want to clear out the Downloads folder before running the download, but
make sure not to delete any saved messages that you want to keep!

1. When you click the Download Now button, the DMA Utility performs an
actual download for this user only and regardless of whether the DMA
Service is running. Rather than using the last saved settings, the download will
be based on the current User Download Settings (including whether to Purge
or Delete the messages) and the current General Settings . This allows you to
make changes to the settings and try them before saving the settings.
2. After you click the Download Now button, the utility reports the results.
» For a successful download, a message similar to the following is displayed:

If the utility is able to access the user account, it reports a successful
download. If the utility saves any files, it reports the number of files saved.
Messages will be downloaded and saved depending on the settings in the
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DMA configuration; that is, the download will depend on settings like
Download All Messages or Download Only New Messages. You can verify
what was saved by checking for the file(s) in the Downloads folder.
» If the utility cannot access the user account, it reports the problem with a
message similar to the following:

If you receive an error, first check the settings, and if you can’t resolve it,
see Troubleshooting on page 29.
Finish Adding the User and Save the Configuration
When you are done with the user configuration (whether you tried the Download
Now button or not), finish adding the user as follows:
1. Click OK to finish adding the user. This will exit the User Download Settings
dialog and return to the main DMA screen, similar to the following:
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2. Save your configuration by clicking the Save button on the toolbar:

.

This completes the instructions on adding a user.
If you have completed the User Settings, you can Start the DMA Service according to
the instructions in Operating the DataMotion Adapter Service on page 28.

Edit User
To edit a user, from the User Settings tab, click on the user in the User List, and click the
Edit User button. (Alternatively, you can double-click on a user displayed in the User
List.) This opens the User Download Settings dialog.
The settings are the same for editing as when adding a user. For a description of these
settings, refer to Add User and Customize Download Settings on page 21.

Delete User
It is not necessary to delete a user if you only want to remove the user from the DMA
Service. To leave the user’s settings in the configuration while suspending the user from
the DMA Service, you can disable the user. You may do this by editing the user and
clicking on the User Enabled checkbox to remove the check mark. (See Add User and
Customize Download Settings on page 21 for more information.)
To delete a user, from the User Settings tab, click on the user in the User List, and click the
Delete User button. A confirmation is displayed, similar to the following:

Click Yes to delete the user or No to cancel.

„ DataMotion, Inc. Confidential and Proprietary Information [#050010 03ƒ

3
Using the DataMotion Adapter
Copyright © 2008 – 2020, DataMotion, Inc. All rights reserved.

Page 26

/ SecureMail
Adapter Guide

v3

SAVE SETTINGS
After making changes to General Settings or User Settings , make sure to save your configuration.
To save your configuration, click the Save button on the toolbar:
. Or you can:
1. Click the File menu.
2. Click Save Settings.
A. If the DMA Service is running, you are asked whether you want to restart the service
after saving the settings:

» Yes: Saves the settings and restarts the DMA Service with the new settings.
» No: Saves the settings but does not restart the DMA Service. The DMA will
not use the new settings until it is restarted.
» Cancel: Cancels and returns to the utility without saving or restarting.
Click on the desired option.
B. If you changed the logging level in General Settings , you are notified that the logging
level will not take effect for the UI.log until the DMA Utility is closed and re-opened.

» Click OK to continue.
If you have completed the User Settings, you can Start the DMA Service according to the
instructions in Operating the DataMotion Adapter Service on page 28.
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OPERATING THE DATAMOTION ADAPTER SERVICE
The DataMotion Adapter is a native Windows Service. The DMA Utility program allows you to
Start, Stop, and Restart the service. To do this, click the appropriate button on the program toolbar
(located at the top left of the utility window).

Refer to the following for information about operating the service:
n

Restart is equivalent to a Stop followed by a Start.

n

When you start the DMA Service, it displays a progress message similar to the following:

n

When you start the DMA Service, it creates a new log file with the filename based on the
date when the service was started.
NOTE: DMA Service Logging only occurs when the service is running. For more
information, see Logging Level under General Settings on page 12.

n

n

When the service is running, it polls the user accounts for messages to download,
according to the configured settings.
The DataMotion Adapter Service can also be managed using the Windows Service
Control Manager (Control Panel> Administrative Tools). Within the Services window,
you can Stop, Start, Pause, Resume and Restart the DataMotion Adapter Service. This is
done by highlighting the DataMotion Adapter service in the list and clicking the
appropriate button on the toolbar.
NOTE: The name of the DMA process in the Windows Task Manager is
svcAdapter.exe.
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TROUBLESHOOTING
Refer to the following information for troubleshooting:
n
n

n
n

To help diagnose an issue, you can review the log files. See Log Files on page 32.
To diagnose an issue in depth, change the General Settings on page 12 Logging Level to
Verbose Logging – Test Mode . This puts the DMA Service in Test logging mode, and
should only be done when the system is being closely monitored, because the SVC.log
file will grow rapidly. While in Test Mode, every action is logged in detail to provide help
in diagnosing problems with the system and the DMA configuration.
To perform a single Download for a user account, see Download Now button on page 24.
To check for proper communication between the host computer and the DataMotion
Server, use the Test button under General Settings on page 12.
To securely retrieve messages, the DMA uses an SSL connection to the DataMotion
Server Web Service. For this reason, the host computer where the DMA Service is
installed must have access to the DataMotion Web Service via an SSL connection on
Port 443. The URL for the Web Service is specified in the General Settings on page 12. If
the DMA Service is running and this connection is severed, it will write an error to the
service log file.

n

n

To download messages from a user account, the Web Services API Integration feature
must be enabled for the account. (See Operating Requirements on page 11). If this feature
is not enabled for the user account, downloading messages from the account will be
unsuccessful and an error will be logged (e.g., “ERROR: Server was unable to process
request. ---> User is not authorized to use the Web Service API. ”). Enablement
must be done by a multi-company admin (“superadmin”) or a DataMotion admin
(Integrator). It cannot be done by a company admin. To inquire about enabling this
feature, contact your support representative.
If a download is not successful and the log file shows “ERROR: 13 The given path’s
format is not supported ” (or a similar message is displayed in a message box when
using Download Now), it could be caused by the use of a non-standard file system
character in a recipient’s or sender’s email address (or the User ID). Windows does not
allow file or folder names to contain symbols and characters such as \ / : * ? ″ < > |. If
downloading to a Directory Tree (General Settings Download Path Type = “Save
downloads to directory tree”), DMA will attempt to use the recipient’s and sender’s
email address to create a folder name, and if either contain a non-standard file system
character, it will cause this error. If downloading using a Client Message Cache (when
User Settings specify a Download Setting of Client Message Cache = Enabled), DMA
will attempt to use the recipient’s email address to create a folder name, and if it
contains a non-standard file system character, it will cause this error.
» To avoid this issue with the recipient’s email address, you can assign the user a
“friendly” User ID that does not contain any of these non-standard characters, and
specify this User ID instead of the email address. (An administrator can assign the
User ID through Member Center> Administrative Tools> Manage Users> Update
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User.) For more information on the Recipient-User-ID and non-standard file system
characters, see User ID on page 21.
» To avoid this issue with the sender’s email address, set the download path to Save
downloads to one directory.
n

If a download appears to be successful but the files were not saved as expected, check
the user’s Default Download Settings and Custom Download Settings, and refer to the
section on Filtering, Downloading, Saving, Deleting, and Track Sent on page 34.
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4
DataMotion Adapter Files

The following information identifies some pertinent DataMotion Adapter (DMA) files.
n

General Files (below)

n

Downloaded Message File Names (below)

n

Log Files (on page 32)

n

Configuration Files (on page 33)

GENERAL FILES
These files are located in the DMA installation folder.
n

n

n

DownloadManager.exe: The DMA Utility program, which is used to configure and
run the DMA Service, among other things. See Configuring the DataMotion Adapter on
page 12.
DownloadCache.txt: The client download cache control file containing Message IDs of
messages that have been downloaded. This file is stored on the local host under the
Downloads folder in a folder named with the recipient’s User ID. See Add User and
Customize Download Settings on page 21.
svcAdapter.exe: The DMA Service program which is run by the DMA Utility. See
Operating the DataMotion Adapter Service on page 28.

DOWNLOADED MESSAGE FILE NAMES
The location for saving downloaded message files is specified in the General Settings on page 12.
Files are saved in the folder specified by the Download Path parameter. The default location for
saved files is the Downloads folder under the DMA installation folder. Also, depending upon the
setting of the Download Path Type parameter, the files are saved directly in the download path
folder or in a subordinate folder structure under the download path folder.
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The DMA automatically creates filenames for all saved files as needed. The names for the saved files
are determined by the Save Method (see User Settings on page 16 for details). In general, the
filenames will be as follows:
n

n

n

If the entire message is saved as a MIME-encoded EML file, the filename will be
<MID>.eml, where <MID> is the unique Message ID identifying the message on the
DataMotion Server. Example: 21274916.eml. (The EML file format contains both the
message body and all file attachments.)
If the message body and attachments are saved as separate files, or only the message
body is saved, the message body is saved as <MID>_Body.txt and/or
<MID>_Body.htm (if HTML body exists), where <MID> represents the unique
Message ID on the DataMotion Server. Example: 21274916_Body.txt.
If attachments are saved separately from the body, they will be saved as decoded files
using their original filename and in their original format.

FILES USING THE SAME NAME
If the Downloads folder or subfolder contains any existing files that have the same name as a
file being saved, the DMA handles it as follows. (This situation is more likely to occur when the
General Settings Download Path Type is set to use Save downloads to one directory.)
n

n

n

If it is an EML file (where the filename is the MID), DMA will overwrite the existing file.
MIDs are unique on the DataMotion Server, so it knows this is an identical message.
If it is a Body.txt or Body.htm file, DMA will save the file by appending “ [1].txt” or
“ [1].htm” to the filename, and it will increment the number for each additional one. For
example, if the message body for same message is downloaded and saved three times to
the same folder, the folder will contain: “21274916_Body.txt”, “21274916_Body.txt
[1].txt”, “21274916_Body.txt [2].txt”.
If it is an attachment file, DMA will save the file by appending “ [1].EXTENSION” to
the filename (where EXTENSION represents the attachment filename extension), and it
will increment the number for each additional one. This is because there may be
different content in the attachments, even though they have the same name. For
example, if an attachment with the same name is saved three times and the attachment is
named Report.pdf, the folder will contain: “Report.pdf”, “Report.pdf [1].pdf”,
“Report.pdf [2].pdf”.

LOG FILES
Log files are located in the folder specified by the Log File Path parameter, which is one of the
General Settings on page 12. The default location for log files is the Logs folder under the DMA
installation folder.
The DMA automatically generates a filename for each new log file. The filename is determined by
the date when the log file is created. The following types of log files are used, where <date>
represents the numeric creation date in month-day-year format (e.g., 09-30-2013):
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<date>_SVC.log: The DMA Service log file, which contains logging information for
the DMA Service. A new log file is created each time the DMA Service is started or
restarted. Logging only occurs in this file while the DMA Service is running.
<date>_UI.log: The DMA User Interface log file, which contains logging information
for the Download Now button on page 24. A new log file is created each time the
Download Now button is used.

When multiple log files are created on the same date, DMA will save the files by appending
“ [1].log” to the filename, and it will increment the number for each additional one; for example:
“09-30-2013_SVC.log”, “09-30-2013_SVC[1].log”, “09-30-2013_SVC[2].log”.

CONFIGURATION FILES
The DMA Utility program allows you to configure the operation of the DMA Service. The DMA
settings are saved in configuration files, which are used to control the operation of the service on the
host. When the DMA Service is started or restarted, it reads the DMA configuration files.
The General Configuration File and User List Configuration File are located in the DMA installation
folder. It is not necessary to edit these files directly, because the utility program does this for you.
However, these files are in XML format and can be parsed and edited by an application program, or
they could be edited manually using Notepad.exe or any popular XML editor application.
IMPORTANT: It is not necessary to edit these files directly, because the utility
program does this for you. However, if you do edit the files, it is critical to retain their
XML structure to ensure the settings can be loaded for proper operation of the DMA.

SVCADAPTER.EXE.CONFIG (GENERAL CONFIGURATION FILE)
The General Configuration File is named svcAdapter.exe.config, and it contains global settings
for the DMA. It must be located in the installation folder.
The General Configuration File contains a parameter called UserListXMLFile, which specifies
the complete path and filename for the User List Configuration File. (This parameter is not
exposed in the DMA Utility.) This parameter must contain a filename, while the path name is
optional. If no path information is present, the installation folder is used by default.
USERLIST.XML (USER LIST CONFIGURATION FILE)
The User List Configuration File is named UserList.xml, and it contains user-specific settings
and DataMotion account credentials for every account that you want polled by the DMA
Service.
NOTE: The User List file contains DataMotion account credentials (User IDs and
Passwords). Although the passwords in this file are stored as encrypted tokens to
protect the user accounts against unauthorized access, you may want to add
appropriate security, such as Windows file system security.
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The User List File is located in the installation folder by default. (Its name and location is
determined by the “UserListXMLFile” field in the General Configuration File.) The file name
and location are not exposed in the DMA Utility (user interface).
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Appendix A:
Supplemental Information

The following information describes supplemental information for the DataMotion Adapter (DMA).
The topics include:
n

Filtering, Downloading, Saving, Deleting, and Track Sent (below).

» Filtering and Action Sequence (on page 35).
» Considerations (on page 36).
» Example 1: All, New, Purge, Only Attachments (on page 37).
» Example 2: All, New, Purge, Only Attachments File Pattern (No Match) (on page 38).
» Download Settings Flexibility (on page 40).

FILTERING, DOWNLOADING, SAVING, DELETING, AND TRACK SENT
You control message downloading, saving, and deleting through filters and parameters specified in
the User Default Download Settings or Custom Download Settings (as described in User Settings on
page 16).
With most Download Settings that are used by customers, messages are downloaded from the
DataMotion Server and saved on the local host. More complicated filter settings, however, provide
additional control for downloading, saving, and deleting. The following information explains how
this works in more detail, especially in relation to how the filters are applied to select messages for
action as well as how the actions affect the message status on the DataMotion Server.
The Download Settings specify filters for downloading messages and saving them on the local host,
and optionally for purging them from the DataMotion Server. These actions also affect the Tracking
of Sent messages, because they mark the messages and their attachments as opened in Track Sent.
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FILTERING AND ACTION SEQUENCE
The Download Settings are applied in the following sequence of filtering and actions:
1. DMA Performs Pre-Download Filtering (on the DataMotion Server)
Pre-Download Filtering selects the messages to download. These filters take effect
before downloading the messages and include the following settings:
A. Download from Folder (Inbox, Inbox & Subfolders, Folder ID)
B. Download all messages or only those with attachments
C. Client Message Cache (Enabled – Download all messages; Disabled – Only
download New messages)
2. DMA Downloads the Selected Messages
A. The messages are downloaded to the client (but not yet saved as files in the
Downloads folder).
B. The messages are marked as opened on the DataMotion Server. This also triggers
Track Sent Notification messages to the senders.
3. DMA Deletes the Selected Messages (if Purge is selected)
When the Purge option is selected, the messages and attachments are permanently and
completely deleted from the user’s secure messaging account on the DataMotion Server.
The messages are not moved to the user’s Trash folder or Deleted Trash folder, and they
cannot be recovered after deletion.
4. DMA Performs Post-Download Filtering (on the Client)
Post-Download Filtering takes effect after downloading the messages to the local host.
It selects the files that are saved, as well as their format. This filtering is specified in the
Save Method settings, which include:
A. Save Entire Message as MIME-encoded .eml file
B. Save Body and Attachments as Separate Files
C. Save Only Body
D. Save Only Attachments
E. Save Only Attachments Matching One or More File Patterns
The first two Save Methods (A & B) always save the message body and any attachments.
The second (C) saves only the body and no attachments. The next two (D & E) save
only attachments and not the body. The last one (E) filters the attachments to save.
5. DMA Saves the Files (on the Client)
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CONSIDERATIONS
The following considerations are worth noting about this sequence of applying the filters and
executing the actions:
n

n

n

Downloading messages from the DataMotion Server is not exactly the same thing as
Saving the messages/attachments as files on the local host. Downloaded messages may
not be saved on the local host, depending on the Save Method settings.
Messages are opened for downloading before any Post-Download Filters are applied.
Any New messages that are opened and downloaded will trigger Track Sent notifications.
(So if messages are downloaded but not saved, they will still have been opened and will
trigger Track Sent notifications.)
Pre-Download Filters are applied before messages are downloaded. One implication of
this is that messages that are excluded by these filters will not be downloaded and
marked as opened, and so they will not trigger Track Sent Notification messages.
» If you select Inbox only, any messages in Inbox subfolders will be excluded from
being opened, downloaded, purged, or saved to file. This includes any new messages
in the subfolders.
» If you select a specific Folder ID, all messages will be excluded except for those in
the specified folder.
» If you select Only with attachments , any messages that do not have attachments
will be excluded from being opened, downloaded, purged, or saved to file. This
includes any new messages that do not have attachments.
» If you select Client Message Cache Disabled (Only download New messages) ,
any previously opened messages will be excluded from being opened, downloaded,
purged, or saved to file.
» If you select Client Message Cache Enabled (Download all messages not in
the cache list) , any messages existing in the cache list will be excluded from being
opened, downloaded, purged, or saved to file.

n

n

If Purge is chosen, messages selected by the Pre-Download Filters are permanently
deleted from the server after they are downloaded but before they are saved on the client
through the Post-Download Filters (Save Method). If the Save Method does not select
the downloaded messages for saving onto the local host, the messages do not exist on
the client and cannot be recovered or restored on the DataMotion Server.
Post-Download Filters (the Save Method) select which downloaded messages are
saved as files on the local host. (Depending on the Save Method, these filters may not
select any of the downloaded messages to save.)
» If you select Save Only Body , any attachments are not saved.
» If you select Save Only Attachments , the message body is not saved, and any
messages downloaded that do not have attachments will not be saved.
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» If you select Save Only Attachments Matching One or More File Patterns , the
message body is not saved, and any messages downloaded that do not have
attachments will not be saved, as well as any messages downloaded that do not have
attachments matching the filename patterns you specify.

EXAMPLE 1: ALL, NEW, PURGE, ONLY ATTACHMENTS
Assuming the Inbox contains one New message with an attachment named Report.pdf and
one New message without attachments, and the following Download Settings are used:
Download from Folder: Inbox.
Download All messages.
Purge: Yes.
Cache: Disabled (Only New Messages).
Save Method: Save Only Attachments.
Note that the Save Method of Only Attachments only saves the attachment and not the
message body.

When this download occurs:
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Both New messages are selected for downloading (through the Pre-Download Filters:
Inbox, All Messages, and New Messages).
Both New messages are opened and downloaded, triggering a Track Sent notification to
the sender of each one.
Both New messages are deleted permanently from the DataMotion Server (Purge).
The Report.pdf attachment from the first message is saved as a file on the local host.
The body of the message is not saved. The second message also is not saved because it
does not contain an attachment.

The result is that both messages are opened, triggering Track Sent notifications, and both
messages are deleted permanently from the DataMotion Server, but only the attachment from
one message is saved on the local host. The message bodies of both messages are not saved and
are not recoverable.
If the Client Message Cache were enabled, the result would be the same, because the Message
IDs for the New messages would not be in the cache control file list (DownloadCache.txt).
These Download Settings are very unusual, but they help to show how the filters function. In
most cases, if you use a Post-Download Filter (Save Method) of Save Only Attachments , you
would also use a Pre-Download Filter of Only with Attachments to avoid the possibly
unwanted consequences of selecting messages that do not have attachments but not saving
them.

EXAMPLE 2: ALL, NEW, PURGE, ONLY ATTACHMENTS FILE PATTERN (NO
MATCH)
This example is the same as Example 1, except for using a File Pattern, with important
differences highlighted in yellow.
Assuming the Inbox contains one New message with an attachment named Report.pdf and
one New message without attachments, and the following Download Settings are used:
Download from Folder: Inbox.
Download All messages.
Purge: Yes.
Cache: Disabled (Only New Messages).
Save Method: Save Only Attachments Matching One or More File Patterns: *.pdfz.
Note that the Save Method of File Pattern only saves the attachment and not the message body.
However, in this example, the File Pattern contains a typographical error (*.pdfz), and so the
attachment filename will not match the pattern and the attachment will not be saved.
NOTE: This example points out the importance of making sure your filename pattern
is correct and will match the attachment filenames that you want downloaded.
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When this download occurs:
n

n

n
n

Both New messages are selected for downloading (through the Pre-Download Filters:
Inbox, All Messages, and New Messages).
Both New messages are opened and downloaded, triggering a Track Sent notification to
the sender of each one.
Both New messages are deleted permanently from the DataMotion Server (Purge).
No messages or attachments are saved on the local host. The Report.pdf attachment
is not saved because the File Pattern does not match. The body of the message is not
saved. The second message, which does not contain an attachment also is not saved
because it does not match the pattern.

The result is that both messages are opened, triggering Track Sent notifications, and both
messages are deleted permanently from the DataMotion Server, and nothing is saved on the
local host. Both messages, including the attachment in the first message, are not saved and are
not recoverable.
If the Client Message Cache were enabled, the result would be the same, because the Message
IDs for the New messages would not be in the cache control file list (DownloadCache.txt).
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These Download Settings are very unusual, but they help to show how the filters function. In
most cases, if you use a Post-Download Filter (Save Method) of Save Only Attachments , you
would also use a Pre-Download Filter of Only with Attachments to avoid the possibly
unwanted consequences of selecting messages that do not have attachments but not saving
them.

DOWNLOAD SETTINGS FLEXIBILITY
The breadth and flexibility of the Download Settings allow you to accomplish a great variety of
downloads to fit your purposes.
For example, you may use the DMA to retrieve DataMotion Secure eForms as PDF
attachments in messages where the message body is empty. In this case, you would use the
filters for Only Attachments and Save Only Attachments.
The Download Settings also allow you to delete all messages from a folder. You can do this as
follows:
n

n
n

Clear the local client message cache list by deleting or moving the DownloadCache.txt
file or the entire Downloads folder.
Select Filters: All Messages, Client Message Cache Enabled, Purge.
If you do not want to save the downloaded messages and attachments as files on the
local host, select Save Only Attachments Matching One or More File Patterns and enter
a filename pattern that won’t be matched, such as “*.NoMatch.”
*

*

*

This represents the end of the DataMotion Adapter Guide for SecureMail.
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